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Temperature Controller MODBUS SIO Driver

Introduction
This manual describes how to connect the Display and the External Device (target Temp. Controller).
In this manual, the connection procedure is described in the sections identified below:

1 || System Configuration
This section lists the types of External
Devices and SIO that you can connect.

&g System Configuration" (page 3)

2 External Device Selection =
Select a model (series) of the External
Device and its connection method.

"2 External Device Selection" (page 7)

3 Communication Settings

This section shows setting examples for
communicating between the Display and
the External Device.

&~ "3 Communication Settings" (page 8)

4 Setup ltems

This section describes communication
setup items on the Display.

Set the Display’s communication settings
in GP Pro-EX or in off-line mode.

Fny Setup Items" (page 24)

5 || Cable Diagrams

This section shows cables and adapters
for connecting the Display and the
External Device.

&5 Cable Diagrams" (page 29)

Operation
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Temperature Controller MODBUS SIO Driver

1 System Configuration

The following table lists system configurations for connecting Fuji Electric Co.,Ltd. External Devices and the

Display.
Cable
Series CPU Link I/F SIO Type | Setting Example B
— . | " Cable
PC Loader F_’ort RS-232C Setting Example 1 Diagram 1"
on CPU Unit (page 8) (page 29)
PXH PXHOOOOO-OOmOO™ .
P . | " Cable
Port on CPU Unit RS_4.22/485 Seiting Example 2 Diagram 2"
(2 wire) (page 10) (page 31)
— . | " Cable
. PC Loader Eort RS-232C Setting Example 3 Diagram 1"
PXG40OMO-00000-0°? |on CPU Unit (page 12) (page 29)
PXG PXG5O00O0MO-00000-0 .
PXGIOOMO-00000-00%2 i nGathi « | " Cable
Port on CPU Uit RS 4_22/485 Setting Example 4 Diagram 3"
(2 wire) (page 14) (page 43)

PXR3OOOO-O0O0MO0-0"
PXRAOOOO-OOMONO ™3™ " Cable

PXR PXRSOCOIC-CICIMOO™ | Port on CPU Unit | <o 422/485 | "Setting Example 5™ | oo oy o
(AutoFIX) | oy r7OOOO-OOmOO™ (2wire) | (page 16) (age 43)
PXROOOOC-OOMOO™
PXR S . | " Cable
(NoAuto- | PXRAOOIOIO-CICIMOICT™®%*6 | Port on CPU Unit ZS\;V“if;’ 485 (Szné”fgxamp'e %" | Diagram 3"
FIX) Pag (page 43)
PUMADDOO-0O0O00 PC Loader Port "Setting Example 7" Cable
PUMBOOOO-OOO0OO on CPU Unit RS-232C (page 20) Diagram 1
PUM PUMEOOOO-OO (page 29)
PUMVOOOO-O000O0OO ] " Cable
PUMNDDOO-00D00 Port on CPU Unit RS_4.22/485 Setting Example 8 Diagram 4"
PUMTOOOO-OOOOO (2 wire) (page 22) (page 55)
*1  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following code:
R (RS-485)
*2  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following codes:
M (RS-485)

V (RS-485 + Digital input (No.1))

K (RS-485 + RSV1)

J (RS-485 + CT1)

F (RS-485 + Digital input (No.1) + RSV1)
U (RS-485 + Digital input (No.1, 2, 3))

*3  The CPU type can be connected with RS-422/485 (2 wire) when the B section includes the following codes:
M (RS-485 Modbus interface)
V (RS-485 Modbus interface + Digital input 1 point)

*4  PXR4 Socket type cannot be connected because it lacks a serial port option.
*5  CPU Unit released in July 2001 or later
*6  CPU Unit released in June 2001 or earlier
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Temperature Controller MODBUS SIO Driver
|

B Connection Configuration

» 1:1 Connection

)

)

External Device

Display

* 1:n Connection

External Device External Device External Device

u J

Display Maximum number of External Devices: 16
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B |[PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

Temperature Controller MODBUS SIO Driver

Usable port
) Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)
com1™, comz,
PS-2000B Com3*L coma - .
PS-3450A, PS-3451A, % * qxo
PS3000-BA, PS3001-BD COMIL, COM2 com2 com2
PS-3650A (T41 model), 1 ] ]
PS-3651A (T41 model) coMl
PS-3650A (T42 model), % % 2
PS-3651A (T42 model) com1™t*2 com2 COM1 CcCoM1
PS-3700A (Pentium®4-M) | COM1™, com2™, 2 o
PS-3710A COM3™2, coM4 com3 CoM3
PS-3711A comM1™ com2™ CoM2™2 COM2*?
PS4000™3 COM1, COM2 - -
com1™2 com2™, 1% %
PL3000 COM3, COM4 coM1 CcCoM1

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.

For connection with External Device, use user-created cables and disable Pin Nos. 1, 4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

DIP Switch setting: RS-232C

DIP Switch Setting Description
1 OFF™1 Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.
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Temperature Controller MODBUS SIO Driver

DIP Switch setting: RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

DIP Switch setting: RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON
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Temperature Controller MODBUS SIO Driver

2 External Device Selection

Select the External Device to be connected to the Display.

,j_}f: Welcome to GP-Pro EX [x]
4 Device/PLT
» evice,
GP-Prole |

Mumber of Devices/PLCs |1 3: g
Device/FLC 1

Manufacturer | Fuiji Electric Co. Lid. |L

Series Temp. Controller MODBUS 510 E

Port COM1 I
Biefer to the manual of this Deviee/PLC
Becent Device/PLC

A 13

= Wse System Area Device Infarmation
£iim

QT

Back [B] Communication Settings | Mew Screen I Canicel

Setup Items Setup Description

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the

Number of Devices/PLCs .
display.

Select the manufacturer of the External Device to connect. Select "Fuji Electric

Manufacturer Co..Ltd.",

Select the External Device model (series) and the connection method. Select "Temp.
Controller MODBUS SIO".

Series In System configuration, make sure the External Device you are connecting is
supported by "Temp. Controller MODBUS SIO".

& System Configuration” (page 3)

Port Select the Display port to be connected to the External Device.

Use System Area Not available for this driver.
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Temperature Controller MODBUS SIO Driver

3 Communication Settings

This section provides examples of communication settings recommended by Pro-face for the Display and the
External Device.

3.1 Setting Example 1
B GP Pro-EX Settings
4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

iii loTc e iy
dagaapas

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 8
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, Digit selection key, or DISP
key located in the operation area on the front of the controller.
Refer to your External Device manual for details.

1 Press SEL key.

2 Press UP key or DOWN key to display [COM].

3 Press SEL key.

4 Press UP key or DOWN key to display the setting parameter.

5 Press SEL key to switch to setting mode.

6 Press UP key, DOWN key or Digit selection key to display the setting value.
7 Press SEL key.

8 Press DISP key twice.

9 Reboot the External Device.

@ Setting Value
Setting Parameter Setting Value Setup Description
SPD2 384 RS-232C communication speed
BIT2 80 RS-232C bit format

GP-Pro EX Device/PLC Connection Manual 9



Temperature Controller MODBUS SIO Driver
|

3.2 Setting Example 2
B GP Pro-EX Settings

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, Digit selection key, or DISP

key located in the operation area on the front of the controller.
Refer to your External Device manual for details.

1 Press SEL key.

2 Press UP key or DOWN key to display [COM].

3 Press SEL key.

4 Press UP key or DOWN key to display the setting parameter.

5 Press SEL key to switch to setting mode.

6 Press UP key, DOWN key or Digit selection key to display the setting value.
7 Press SEL key.

8 Press DISP key twice.

9 Reboot the External Device.

@ Setting Value

Setting Parameter Setting Value Setup Description
STN4 1 RS-485 station No.

SPD4 384 RS-485 communication speed
BIT4 80 RS-485 bit format

GP-Pro EX Device/PLC Connection Manual 11
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3.3 Setting Example 3
B GP Pro-EX Settings
4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

iii o T
dagaapas

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings

GP-Pro EX Device/PLC Connection Manual 12



Temperature Controller MODBUS SIO Driver
|

B External Device Settings

External Device communication settings are fixed as indicated below.

Setting Items Setting Value
Communication speed 9600
Data length 8
Stop bit 1
Parity None

GP-Pro EX Device/PLC Connection Manual 13
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|

3.4 Setting Example 4
B GP Pro-EX Settings

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, DOWN key, or USER key, located in the
operation area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to switch to Monitor Mode.
2 Press and hold SEL key to switch to Setup Mode.
3 Press UP key or DOWN key to display [CoM Ch 9].
4 Press and hold SEL key.
5 Press UP key or DOWN key to display setting parameter.
6 Press SEL key.
7 Press UP key or DOWN key to display setting value.
8 Press SEL key.
9 Press USER key.
10 Reboot the External Device.

@ Setting Value

Setting Parameter Setting Value Setup Description
STno 1 ST No. setting

CoM 960d RS-485 Baud rate/Parity settings
SCC rw RS-485 Communication permissions
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|

3.5 Setting Example 5
B GP Pro-EX Settings

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

=
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, or DOWN key located in the operation
area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to display the 3rd block parameter.
2 Press UP key or DOWN key to display setting parameter.
3 Press SEL key.

4 Press UP key or DOWN key to display setting value.

5 Press SEL key.

6 Press and hold SEL key.

@ Setting Value
Setting Parameter Setting Value Setup Description
STno 1 Station No.
CoM 0 Parity setting
PCoL 1 Communication protocol
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3.6 Setting Example 6
B GP Pro-EX Settings
4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

iii loTc e iy
dagaapas

@ Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual D 3 E

PR Series(NodutoFl) i
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B External Device Settings
For External Device communication settings, use the SEL key, UP key, or DOWN key located in the operation
area on the front of the controller.

Refer to your External Device manual for details.

1 Press and hold SEL key to display the 3rd block parameter.
2 Press UP key or DOWN key to display setting parameter.
3 Press SEL key.

4 Press UP key or DOWN key to display setting value.

5 Press SEL key.

6 Press and hold SEL key.

@ Setting Value
Setting Parameter Setting Value Setup Description
STno 1 Station No.
CoM 0 Parity setting
PCoL 1 Communication protocol

GP-Pro EX Device/PLC Connection Manual 19



Temperature Controller MODBUS SIO Driver
|

3.7 Setting Example 7
B GP Pro-EX Settings

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings

Temperature Controller MODBUS SIO Driver

For External Device communication settings, use the Station No. Configuration switch on the front of the

controller.

Refer to your External Device manual for details.

1 Set"0" to Station No. Configuration switch.

NOTE « The Station Number is generated by adding 1 (one) to the value set by the Station No.
Configuration switch.

Other communication settings are fixed as below.

Setting Items

Setting Value

Communication speed 19200
Data length 8
Stop bit 1
Parity None
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|

3.8 Setting Example 8
B GP Pro-EX Settings

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] ﬁ .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add
Device] to add another External Device.

#* Individual Device Settings
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B External Device Settings

For External Device communication settings, use the Station No. Configuration switch on the front of the
controller and Parameter Loader software (PUM Loader).
Refer to your External Device manual for details.

1 Set"0" to Station No. Configuration switch.

NOTE « The Station Number is generated by adding 1 (one) to the value set by the Station No.
Configuration switch.

2 Start up the Parameter Loader software.
3 Select [Control/Event/Analog Module] in the [Module type selection] dialog box.
4 Click [OK].
5 Select the any mode in the [Startup mode] dialog box.
6 Click [OK].
7 Select [Control module]-[Parameter]-[Communication] in the tree view of the main window.
8 Click the setting item to display the selection dialog box of the setting value.
O Select the setting value.
10 Click [OK].
11 Transfer the communication settings to External Device.

@ Setting Value

Setting Items Setting Value
RS-485 Parity setting None
RS-485 Communication speed 19.2Kbps
RS-485 Communication permission 1
RS-485 Response interval time 1
Enhanced comm. module (PUMC) connection 0
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4 Setup Items

Set up the Display’s communication settings in GP Pro-EX or in the Display’s off-line mode.
The setting of each parameter must match that of the External Device.
&~ "3 Communication Settings" (page 8)

4.1 Setup Items in GP Pro-EX

B Communication Settings
To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer IFuii Electric Co. Ltd. Series Temp. Contraller MODBLS 510 Port  |COR1
Text Data Mode I‘I_ LChange

Communication Settings

510 Type ¥ R5232C = RS 422/485(2wire] = RS 422/485(4wire]
Speed lm

Data Length 7 [l

Parity ' NONE " EVEN . 0DD

Stop Bit 1 -

Flows Contral ' NONE " ER[DTR/CTS) KON /XOFF

Timeout m [zec)

Fietry m

wiat To Send [0 = ms)

Rl #vCC & Rl WL

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's R5232C
Isolation Unit, please select it to WCC. Diefault

Device-Specific Settings

Alloweable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo, Device Mame Seftings Device
[&] 1 Jrc [l [Series=FG Series Station No.=1

Setup ltems Setup Description

Select the SIO type to communicate with the External Device.

Tln the communication setting, confirm the serial interface specifications of the Display
SIO Type and set [SIO Type] correctly.

If you select an SIO type the serial interface does not support, we cannot guarantee the
operation.

Please refer to the manual of the Display for more detail on the serial interface
specifications.

Speed Select communication speed between the External Device and the Display.
Data Length Display data length.

Parity Select how to check parity.

Stop Bit Select stop bit length.

Continues to the next page.
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Setup ltems Setup Description
Select the communication control method to prevent overflow of transmission and
Flow Control .
reception data.
' Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
In case of no response from the External Device, use an integer from 0 to 255 to enter how
Retry . - .
many times the Display retransmits the command.
Wait To Send Use an integer fro_m_O to 255 to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.

Please refer to the manual of the IPC for more detail.

« Refer to the GP-Pro EX Reference Manual for Indirect Device.

GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"

W Device Setting

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

#* Individual Device Settings

PLC1

Series |PXG Series |

If you change the series, please reconfirm all address settings.

Station No. |1 3:
Default |

0K () Cancel |

Setup ltems Setup Description
Series Select the series of the External Device.
Station No. Use an integer from 1 to 255 to enter the Station number of the External Device.
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4.2 Setup Items in Off-line Mode

» Refer to the Maintenance/Troubleshooting manual for information on how to enter off-line

mode or about the operation.
Cf. Maintenance/Troubleshooting Manual "Off-line Mode"

« The number of the setup items to be displayed for 1 page in the off-line mode depends on the

Display in use. Please refer to the Reference manual for details.

B Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings] in off-line mode.

Touch the External Device you want to set from the displayed list.

| Cormm, Device Option

Temp, Controller MODBUS SI0 [GOM1] Page 1/1
SI0 Type RS422/485(2wire) e
Speed 96m0 =i
Data Length 8
Parity NONE EVEN e (DD
Stop Bit o | ?
Flow Gontrol JNONE >
Timeout(s} T w | a
Retry 7w | A
Wait To Send(ms) 1 | a

: 20m8/12/22
| Enit | Back 15:12:18
Setup Items Setup Description
Select the SIO type to communicate with the External Device.
IMPORTANT
In the communication setting, confirm the serial interface specifications of the Display and
SIO Type set [SIO Type] correctly.
If you select an SIO type the serial interface does not support, we cannot guarantee the
operation.
Please refer to the manual of the Display for more detail on the serial interface
specifications.
Speed Select the communication speed between the External Device and the Display.

Data Length

Display data length.

Parity

Select how to check parity.

Stop Bit

Select stop bit length.

Continues to the next page.
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Setup Items Setup Description
Select the communication control method to prevent overflow of transmission and reception
Flow Control
data.
) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
In case of no response from the External Device, use an integer from "0 to 255" to enter how
Retry . - .
many times the Display retransmits the command.
Wait To Send Use an integer fro_m_ 0 to 255" to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.

W Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the
External Device you want to set from the displayed list, and touch [Device].

Cormnm, Device Option
Temp, Controller MODBUS SI0 [GOM1] Page 1/1
Device/PLC Name [PLCI ==
Series PHR Series{AutoFIH}

Station No. | 1 vl al
; 2ns/12/22
Enit Back 1512600

Setup ltems Setup Description

Select the External Device to set. Device name is a title of the External Device set with GP-

Device/PLC Name Pro EX. (Initial value [PLC1])

Series Display the series of the External Device.

Station No. Use an integer from 1 to 255 to enter the Station number of the External Device.
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W Option
To display the setting screen, touch [Device/PLC Settings] from [Peripheral Equipment Settings]. Touch the
External Device you want to set from the displayed list, and touch [Option].

Setup ltems Setup Description
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE e GP-4100 series, GP-4*01TM and LT-4*01TM do not have the [Option] setting in the offline
mode.
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5 Cable Diagrams

The following cable diagrams may be different from cable diagrams recommended by Fuji Electric Co.,Ltd.

Please be assured there is no operational problem in applying the cable diagrams shown in this manual.

* The FG pin of the External Device body must be D-class grounded. Refer to your External Device manual for
more details.

e The SG and FG are connected inside the Display. When connecting the External Device to the SG, design
your system to avoid short-circuit loops.

* Connect an isolation unit if the communication is not stable due to noise or other factors.

Cable Diagram 1

Display

. Cable Notes
(Connection Port)

GP3000 (COM1)
GP4000"! (COM1)
ST (COM1)
LT3000 (COM1)
IPC™?

PC/IAT

1A | Loader connecting cable by Fuji Electric Systems Co., Ltd."®

User-created cable
GP-4105 (COML1) 1B +

Loader connecting cable by Fuji Electric Systems Co., Ltd."®

*1  All GP4000 models except GP-4100 Series and GP-4203T

*2 O%the COM port which can communicate by RS-232C can be used.
"® [PC COM Port" (page 5)

*3  The loader connecting cable differs, depending on the series.

Series Loader connecting cable type
PXH ZZPPXH1*TK4H4563
PUM PUMZ*L01
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1A)
Display Display side External Device side
D-Sub 9pin $2.5 triple pole miniature jack
[P —-=
Loader connecting cable
NOTE < Connect the loader connecting cable to the PC loader port of the External Device.
1B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Signal 3 Pin Signal
Display name, name Display side External Device side
RD(RXD) 2 RD(RXD) D-Sub 9pin $2.5 triple pole miniature jack
SD(TXD) 3 SD(TXD)
ER(DTR) 4 |ER(DTR) @ g ——)
SG 5 SG Loader connecting cable
RS(RTS) — 7 |Rs(RTS)
CS(CTS) L - 8 CS(CTS)
1
User-created cable
NOTE I ¢ Connect the loader connecting cable to the PC loader port of the External Device.
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Cable Diagram 2

Temperature Controller MODBUS SIO Driver

Displ
ISp. = Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
. CA3-ADPCOM-01
GP3000"! (COM1) +
AGP-3302B (COM2) 2A Terminal block conversion adapter by Pro-face
GP-4*01TM (COMI) CA3-ADPTRM-01
ST (COM2) +
LT3000 (COM1) User-created cable
2B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
2C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000™3 (COM2) +
User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
2D +
User-created cable Cable length:
3 500m or less
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
“ 2E Terminal block conversion adapter by Pro-face
IPC CA3-ADPTRM-01
+
User-created cable
2F User-created cable
GP-4106 (COM1) 2G User-created cable
GP-4107 (COML1)
GP-4*03T"° (COM2) 2H User-created cable
GP-4203T (COML1)
RS-422 Terminal Block Conversion Adapter by Pro-face
. ’l PFXZCBADTM1"™/
GP4000"® (COM2) +
GP-4201T (COM1) User-created cable
2B User-created cable
RJ45 RS-485 Cable (5m) by Pro-face
. ka
LT-4*01TM (COM1) 2] PFXZLMCBRJR81

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4 O%the COM port which can communicate by RS-422/485 (2 wire) can be used.
"W IPC COM Port" (page 5)
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*5  Except GP-4203T

*6  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 2A.

IMPORTANT S Implement Type D installment to the shield connected to the FG.
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2A)

e 1:1 Connection

Display

CA3-ADPCOM-01

* 1:n Connection

Display

CA3-ADPTRM-01

CA3-ADPCOM-01

Display side
Terminal Block . .
I Shield External Device side
Signal name i
g K ","\‘ Termlnal BIOCk Terminaﬁon
TERMRX : ! Pin |Signal name| resistance
RDA PH A _-' L 100Q
[ C1 “ /\ i *
/1 RDB |e —> 16 -
CA3-ADPTRM-01 SDA .15 SG
SDB :
SG
FG
User-created cable
Display side
Terminal Block ) . ) .
- Shield External Device side External Device side
Signalname [ ___ =" e Terminal Block Terminal Block -
) R . - Termination
TERMRX [ ;% | Pin [Signalname| _Shield_ Pin |Signal name|resistance
= RDA /A :: : 12 n A:, A :' -: > 124 A 1000
// — RDB  |e-fy 16 | - e S—blie | -
SDA |- +— 15 | SG —— 15 | SG
SDB : 1
SG )
FG

v

A

User-created cable
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2B)
e 1:1 Connection
Display side External Device side
. D-Sub 9pin (socket) Terminal Block I
Termination ) Termination
resistance | Pin |Signal name Shield Pin [Signal name| resistance
100Q ;ST 100Q
1 RDA [¢—¢—A——> 14 +
Display 2 RDB | : /\_._'..> 16 —
3 | SDA |— . —— 15 | SG
7 | SDB — P
5 SG . :
4 ERA ::l
8 | CSA |« b
9 | ERB :’ Vo
6 | csB ; L
.......... )(’
shell | FG |—7T
» 1:n Connection
Display side External Device side External Device side
. D-Sub 9pin (socket) Terminal Block Terminal Block -
Termination . X Termination
resistance | Pin | Signal name Shield Pin |Signal name Shield Pin [Signal name| resistance
100Q ST - 10002
% 1 RDA &+ —» 14 + < > 14 +
Display 2 | ROB |e— / L—» 16 - <-J \—‘—* 16 -
3 | spbA | 115 | s6 (——] 15| sc
7 |soB bid 0+ T 1
5 SG
4 ERA
8 CSA
9 ERB
6 CSB
Shell | FG
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2C)
e 1:1 Connection
Display side
Terminal Block . .
External Device side
Signal name i i
Displa: d Sh|eld’ Terminal Block Termination
play TERMRX —+ Pin |Signal name| resistance
' L H 100Q
[ — RDA |4 / ——> 14 + %
7& RDB : \__> 16 -
CA3-ADPTRM-01|  SDA : 15 SG
CA4-ADPONL-01 H :
SDB .
SG /
FG
User-created cable
e 1:n Connection
Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block Terminal Block o
Display pmmmmmmmma 3, - - . - - Ter_mlnatlon
TERMRX [— FY Pin |Signal name Shield Pin [Signal name| resistance
: i ST bl 100Q
[ [ RDA : : 14 + - = 14 +
/LI roe o 16| - 4—.] \__, 16| -
CA3-ADPTRM-01 [ SDA : 15 SG + 15 SG
CA4-ADPONL-01 SDB  b—d A ;l_
SG
FG

v

A

User-created cable
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2D)
e 1:1 Connection

Display side

D-Sub 9pin (plug) . .
External Device side

Pin | Signal name Shield ;
Displa : ymmmmmmmna—nn R Terminal Block Termination
Pay 1 |TERMRX [— H Pin |Signal name| resistance
H N 100Q
2 RDA |« / ——> 14 + %
7 RDB ; \—~—> 16 _
3 SDA . 15 SG
CA4-ADPONL-01 H '
8 SDB T :
5 SG : :
Shell FG
User-created cable
e 1:n Connection
Display side
D-Sub Spin (plug) External Device side External Device side
. Pin | Signal name SI’IIEId, Terminal Block - Terminal Block oo
Display 1 |TERMRX [—F Pin |Signal name| ~ Shield Pin |Signal name flfzs(;gaﬂce
2 | rROA |& /A sl | o+ AT e |+ El
7 | ROB e \——> 16| - e Yol | -
3 | spa |4 L+ 15| sG |[———+—15 | SG
CA4-ADPONL-01 8 SDB ' --._.l_
5 SG
Shell FG

A\ 2

A

User-created cable
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2E)
e 1:1 Connection

Display side
Terminal Block . .
) External Device side
Signal name Shield Terminal Block o
. gt K Termination
Display TERMRX — R Pin |Signal name| resistance
[ = I AN I S
/1 RDB |& ——> 16 -
CA3-ADPTRM-01 SDA | : — 15 SG
CA3-ADPCOM-01 SDB B H
SG :
FG
User-created cable
* 1:n Connection
Display side
Terminal Block _ External Device side External Device side
Signalname [ Shield Terminal Block Terminal Block o
. K K Termination
Display TERMRX — ;% | Pin |Signal name Shield Pin |Signal name| resistance
H . T, g 1000
P A A
[ (- RDA ~ / r 14 + 14 + %
// L1 RDB —— 16 - e S 16 -
CA3-ADPTRM-01 SDA 115 | SG —— 15 | SG
CA3-ADPCOM-01 SDB S T 1
SG ’
FG

v

A

User-created cable
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2F)
e 1:1 Connection

Display side External Device side
... D-Sub 9pin (socket) Terminal Block s
Termination . Termination
resistance | Pin |Signal name Shield Pin |Signal name| resistance
100Q ST 100Q
1 |[DATA+ [ —» 14 + %
Display 2 [DATA- <—.—/ \——> 16 -
3 | NC : i —— 15 | SG
7 NC : P
5 |GND(SG) — P
4 ERA ::l
8 CSA T b
9 ERB :l
6 | csB v
.......... )l'
shell | FG |—T
e 1:n Connection
Display side External Device side External Device side
Termination D-Sub 9pin (socket) . Terminal Block . Terminal Block Termination
resistance | Pin |Signal name Shield Pin |Signal name Shield Pin [Signal name| resistance
100Q LT 100Q
% 1 |[DATA+ |« » 14 + D T 14 + %
Display 2 |pATA- 16| - | S| -
3 | nNc 15 | s6 [=——= 15| sG
7 [ne | 200 T 1
5 |GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
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2G)
e 1:1 Connection
Display side External Device side
Terminal block Terminal Block o
o ) Termination
Termination |Signal name Shield Pin |Signal name| resistance
resistance™1 REEEEECEELEETY 100Q
%RDA<; A—— 14 + %
Display RDB .-' / L 16 -
SDA |— 15 | SG
SDB |—
SG ;
ERA [—
CSA :
ERB
CSB
e 1:n Connection
Display side External Device side External Device side
Terminal block Terminal Block Terminal Block L
. i Termination
Termination | Signal name Shield Pin |Signalname| ~ Shield Pin |Signal name| resistance
resistance*1 RDA le SR " N . ',"';‘"“."_“ 12 N 100Q
Display RDB |e /\_-_..> I'_ 16 - "'—‘ \_'_"' 16 -
SDA P sG ——{ 15| sa
SDB L
SG
ERA
CSA
ERB
CSB

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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2H)
e 1:1 Connection

Display side External Device side
Termination D-Sub 9pin (plug) . Terminal Block Termination
resistance Pin Signal name Shield Pin |Signal name| resistance
1000 D 1000
3 LINE(+) [¢— b 14 +
Display 8 LINE(-) 4__/\_._._, 16 -
1 NG i~ 15 | sG
2 | we | i
5 | GND(sG) [
4 | RsEmTS) | |
6 5V
7 NC
9 NC | "‘-,':
Shell FG —
« 1:n Connection
D-gdip;))i/:i(?)?ug) External_ Device side Externa! Device side
Termination Terminal Block Terminal Block Termination
resistance Fin | Signal name Shield Pin [Signal name Shield Pin [Signal name] resistance
1000 ; UNEE) ” e ,\‘ ” " 1000
by LINE() 6| - |« \—'—* 6| - =
1| e 195 | s6 ——+1 15 | sG
2 NC T 1
5 | GND(SG) : h
4 | RS(RTS)
6 5V
7 | N ' I
g | e 3
shel | PG |—T7TTTTTTC >

IMPORTANT The 5V output (Pin #6) on the Display is the power for the Siemens AG’'s PROFIBUS
connector. Do not use it for other devices.

NOTE I

¢ |In COM on the GP-4107, the SG and FG terminals are isolated.
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21)
e 1:1 Connection
Display side
Terminal Block . .
Sanal Shield External Device side
ignal name i
| 9 P s, _Terminal BIock oinaion
Display TERMRX [— ;% | Pin [Signal name| resistance
RDA |e . A N . 1000
[ - “ / 14 %
7@ RDB e SEELIN P -
PFXZCBADTM1 SDA .15 SG
SDB ;
SG
FG
User-created cable
e 1:n Connection
Display side
Terminal Block X . . .
- . External Device side External Device side
Signal name Sh'eld _____ Terminal Block Terminal Block o
. J R i Termination
Display TERMRX[— .\ | Pin [Signalname|  Shield Pin |Signal name|resistance
o AL A 1000
[ — RDA “ / > 14 + 14 +
// [ RDB |« —— 16 - e S 16 -
PFXZCBADTM1 SDA = L~ 15 S +— 15 SG
SDB [ 1
SG -
FG

A\

A

User-created cable
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2J)

e 1:1 Connection

Display

(1

e 1:n Connection

Display

External Device side

Terminal Block

Termination
Pin [Signal name| resistance
D1 1000
DO 16 _
GhD 15 SG

External Device side

Termination External Device side
;ezs(;;tance Terminal Block Terminal Block Termination
(1/4W) . ) : . .
\ Pin |Signal name Shield Pin |Signal name| resistance
D1 A 2200Q(1/4W)
g 14 + «7 T 14 +
o~ 16 | - & e | -
(1 15 SG ) — 15 SG
- o
User-created Cable
Number Name Notes

@

RJ45 RS-485 Cable (5m) by Pro-face

PFXZLMCBRJRS81
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Cable Diagram 3

Temperature Controller MODBUS SIO Driver

Displ
ISp. = Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
. CA3-ADPCOM-01
GP3000"! (COM1) +
AGP-3302B (COM2) 3A Terminal block conversion adapter by Pro-face
GP-4*01TM (COMI) CA3-ADPTRM-01
ST (COM2) +
LT3000 (COM1) User-created cable
3B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
3C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000™3 (COM2) +
User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
3D +
User-created cable Cable length:
3 500m or less
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
“ 3E Terminal block conversion adapter by Pro-face
IPC CA3-ADPTRM-01
+
User-created cable
3F User-created cable
GP-4106 (COM1) 3G User-created cable
GP-4107 (COML1)
GP-4*03T"° (COM2) 3H User-created cable
GP-4203T (COML1)
RS-422 Terminal Block Conversion Adapter by Pro-face
. 3l PFXZCBADTM1"™/
GP4000"® (COM2) +
GP-4201T (COM1) User-created cable
3B User-created cable
RJ45 RS-485 Cable (5m) by Pro-face
. ka
LT-4*01TM (COM1) 3J PFXZLMCBRJR81

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4 O%the COM port which can communicate by RS-422/485 (2 wire) can be used.
"W IPC COM Port" (page 5)
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*5  Except GP-4203T
*6  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.

IMPORTANT l’g:irglsnal number used for communication differs depending on the External Device
Terminal numbers corresponding to each series are shown below. SG terminals are
not available for these series. Apply masking using insulation tape, etc. Implement
Type D installment to the shield connected to the FG.

Series + -
PXG4 7 8
PXG5/PXG9 1 2
PXR3 15 14
PXR4/PXR7
PXR5/PXR9 1 2
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3A)
e 1:1 Connection
Display side
Terminal Block . .
) External Device side
Signal name .. Shield Terminal Block
Display ' B \ . Termination
TERMRX ; §od Signal name resistance
P A [ 100Q
[ I_I RDA : / I'. : +
(L1 RDB |e s - %
CA3-ADPTRM-01 SDA =
CA3-ADPCOM-01 SDB : Voo
SG 3, Y
Fe
User-created cable
e 1:n Connection
Display side
Terminal Block ) External Device side External Device side
Signal name |~ ___ Shield Terminal Block Terminal Block
) ; R ) - Termination
Display TERMRX [— /% |Signalname| _ Shield Signal name|  resistance
; NN TN 100Q
[ I:I RDA ‘:- / :. -:.r + :, :. .‘I +
// 1 RDB [« e - e L
CA3-ADPTRM-01 SDA _"
CA3-ADPCOM-01 SDB J R 1
SG S i
Fe |

v

A

User-created cable
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3B)
e 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Termination - - . - Termination
resistance Pin_|Signal name .._?.h.l?lc.j-.., Signal name - resistance
100Q 1 RDA |e '.' A AN + 100Q2
Display % 2 RDB |« ! /\_"_'..> - %
3 | sbA |— P
7 | sbB |— P
5 | sG | P
4 ERA ::l
8 | CsSA T Vo
9 ERB :l Vo
6 | CsB : s
.......... y’
shell | FG |—T
e 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block Terminal Block
T inati . . Ti inati
Totance Pin [Signal name __Sh'eld Signalname| _Shield |Signal name e
1009% 1 | RDA |e—i4—A—" +  J&—A— + %1009
Display 2 | RDB |e— /\—~—» - 44—/\——> -
3 | sbA | P | L
7 | spB | P 1
5 | sG : P
4 ERA ::I : :
8 | csa |«
9 ERB :| Vo
6 | csB |+ i
shell | FG |—Y" "
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3C)
e 1:1 Connection

Display side
Terminal Block

External Device side

Signal name Shield Terminal Block

DlSplay TERMRX Lo '-'"‘ S|gna| name Termination

resistance
CJ RDA + %1009
7& RDB

CA3-ADPTRM-01 SDA
CA4-ADPONL-01
SDB

SG

FG 17T ’

A

T~
F'
|

A

User-created cable
¢ 1:n Connection
Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block Terminal Block
Display TERMRX —— 7 [signalname]  shield  [signalname] Termination
=1 roA |« At A s 10002
[//: RDB e /L, - <~J\—> - %
CA3-ADPTRM-01 | SDA | _______
CA4-ADPONL-01 SDB '.“ '.‘ :.- - 'J:_
SG L
FG 1 T }

A

A\

User-created cable
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3D)
e 1:1 Connection

Display side
D-Sub 9pin (plug)

- . ) External Device side
P|n S|gna| name Shield Terminal B|ock
Displa ST ” . inati
play 1 |TERMRX [— /% [Signalname| ~ Termination
/ N resistance
2 RDA [t / —>  + %1009
7 RDB :: \—'—b -
3 | sbA = b
CA4-ADPONL-01 . ! :
8 SDB T ' h
5 SG
shel [ FG  |—T
User-created cable
e 1:n Connection
Display side
D-Sub 9pin (plug) External Device side External Device side
Pin | Signal name| Shield Terminal Block Terminal Block
Display T : : - Termination
1 [TERMRX 7 O Signal name ShI6|d, Signalname| | cictance
2 RDA |e+ Al iyl 4 le— A _;5:009
7 | roB |« / \a—-—r - <J \—-—> -
3 | spA |+ L
CA4-ADPONL-01 8 SDB : _l_
5 SG L
shel | F6  —1 T

\4

User-created cable
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3E)

1:1 Connection

Display side
Terminal Block . )
hield External Device side
Signalname |~ ___ Shield Terminal Block
Display TERMRX —- ; K Signal name Termination
. A ! H resistance
[ | RDA < :. / :, .: » + %IOOQ
/L1 RDB |e s -
CA3-ADPTRM-01 SDA :
CA3-ADPCOM-01 SDB : Voo
SG o N
=g
User-created cable
¢ 1:n Connection
Display side

Terminal Block

Display

Signal name
TERMRX

External Device side
Terminal Block

............. o

Signal name

External Device side
Terminal Block

Signal name| ~ Termination

resistance

»

RDA
RDB
SDA
SDB
SG
FG

I

1
/1
/
CA3-ADPTRM-01
CA3-ADPCOM-01

JARER

+ « +

% 1000

.
.
[
v
v
L
O
'
.
'
'
'
'
'
il
.
.
]
'
.

v

User-created cable
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3F)
e 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Termination - : inati
. Pin  |Signal name Shield Signal name| ~ Termination
resistance g LT N g resistance
1000 % 1 |[DATA+|[e——A— + %,1009
Dlsplay 2 DATA- B L _
3 | NC | P
7 NC .
5 |GND(SG)| :
4 ERA :I
8 | CSA T Vo
9 | ERB :l Vo
6 [ CsB : L
---------- él'
shell | F6 |—1
e 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block Terminal Block
Termination : . Shield ! ; ) Termination
fesistance | _Pin_[Sgalnane| SN ..., [Ponelname|  Shield — [Signalnamef o ctance
1000 1 |DATA+|e——A—2 v Je—A— 1000
Display % 2 |pbaTa- 4—/ \——» - 4—~J \—~> _ %
3 | NCo| P L
T e | P e
5 |onpse)| Do
4 ERA ::I
8 | csa |«
9 ERB ::l
6 | csB ~ ;
Shell | FG |— T B
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3G)
e 1:1 Connection

Display side External Device side
Terminal block Terminal Block
Sional Shield Sinal Termination
L Ignal nam Ignal nam i
Termination gnainamey - CUET X gnainame|  resistance
resistance*1 RDA |e— A AN 10002
Display % RDB e /\ RN %
SDA - o
SDB |— .
SG ; P
ERA ::l
CSA |+ b
ERB :l‘, o
CSB - v
e 1:n Connection
Display side External Device side External Device side
Terminal block Terminal Block Terminal Block
- . - ) : Terminati
Termination | Signal name Shield Signalname] ~ Shield [Signalname|  rouiotarce
resistance*1 RDA < SR > . 1',' A '.".‘ N n 1000
Display % RDB < '-: /\_""_I'.__» _ 4.4'_/\5_;_> _ %
SDA Pt B Vi
SDB P nE
se |1 i
ERA ::I
CsA ; P
ERB :|'. Lo
CSB L

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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3H)
e 1:1 Connection

Display side External Device side
D-Sub 9pin (plug) Terminal Block
Termination . - inati
resistance Pin | Signal name . -Sk_“elfj . Signal name -rl;eesriglg]:;gm
100Q «—i A LIS
Displa . r
il 8 | Lnep [+ e -
1 NC : P
2 NC ; P
5 GND(SG) | P
4 RS(RTS) | ! b
6 5V : v
7 NC : Vo
9 NC | L
Shell 6 —1 T v
e 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (plug) Terminal Block Terminal Block
Termination pi Signal Shield . ; : Termination
o in lgnalname | Sh |_e_ Signal name "_‘_S_h_|_e_lc_1_',‘ Signal name| - ce
100Q 3 LINE(+) |e—= A - it + at A — + %10022
Display % 8 LINE(-) <_/ "' "‘ - 4_AJ\,—_> -

T Twe |0 i Y

2 NC : —:L

5 | eNDsG) | i .

4 | msmrs) | i

6 5V : o

7 NC ;

9 NC .

Shell F6 —T T }

IMPORTANT 8 The 5V output (Pin #6) on the Display is the power for the Siemens AG’'s PROFIBUS
connector. Do not use it for other devices.

NOTE I ¢ In COM on the GP-4107, the SG and FG terminals are isolated.
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3l)
e 1:1 Connection

Display side

Terminal Block External Device side

Signal name Sh'9|d _____ Terminal Block
Displa : S . Termination
play TERMRX— Y Signal name| e
! Ao Ly 100Q
< 2 > +
83 et/ _—=
/1 RDB |e — -
PFXZCBADTM1 SDA = '
SDB [ Vo
SG Y
6
User-created cable
e 1:n Connection
Display side
Terminal Block ) External Device side External Device side
Signal name .. Shield Terminal Block Terminal Block o
. M N Termination
Display TERMRX [— .\ |Signal name Shield Signal name| resistance
- PN PN 1000
[ AT gy gy N g S N oy W g
//I:I RDB |e+-l+ — - i — _
PFXZCBADTM1 SDA —" : '\. ;
SDB J . -
SG o i
Fo |

v

A

User-created cable
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3J)

e 1:1 Connection

Display

* 1:n Connection

External Device side
Terminal Block

Signal name Termination
D1 resistance
+ %1 00Q
@:/ Do N

(1)

Termination External Device side

External Device side

resistance Terminal Block Terminal Block
2200(1/4W) Signal name Shield Signal name| ~ Termination
Display D1 TR resistance
+ e 4 220Q(1/4W)
S «_/ \_, _ %
- - -
User-created Cable
Number Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRJR81
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Cable Diagram 4

Temperature Controller MODBUS SIO Driver

Displ
ISp. = Cable Notes
(Connection Port)
COM port conversion adapter by Pro-face
. CA3-ADPCOM-01
GP3000"! (COM1) +
AGP-3302B (COM2) 4A Terminal block conversion adapter by Pro-face
GP-4*01TM (COMI) CA3-ADPTRM-01
ST (COM2) +
LT3000 (COM1) User-created cable
4B User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
+
4C Terminal block conversion adapter by Pro-face
CA3-ADPTRM-01
GP3000™3 (COM2) +
User-created cable
Online adapter by Pro-face
CA4-ADPONL-01
4D .
User-created cable Cable length:
3 500m or less
COM port conversion adapter by Pro-face
CA3-ADPCOM-01
+
“ 4E Terminal block conversion adapter by Pro-face
IPC CA3-ADPTRM-01
+
User-created cable
4F User-created cable
GP-4106 (COM1) 4G User-created cable
GP-4107 (COML1)
GP-4*03T"° (COM2) 4H User-created cable
GP-4203T (COML1)
RS-422 Terminal Block Conversion Adapter by Pro-face
. Al PFXZCBADTM1"™/
GP4000"® (COM2) +
GP-4201T (COM1) User-created cable
4B User-created cable
RJ45 RS-485 Cable (5m) by Pro-face
. ka
LT-4*01TM (COM1) 4] PFXZLMCBRJR81

*1  All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4 O%the COM port which can communicate by RS-422/485 (2 wire) can be used.
"W IPC COM Port" (page 5)
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*5  Except GP-4203T

*6  All GP4000 models except GP-4100 Series, GP-4*01TM, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 4A.
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4A)
e 1:1 Connection

Display side

Terminal Block . .
External Device side

Signal name Sh'eld, Terminal Block
Display TERMRX —- P Signal name Termination
. N H resistance
[ = RDA [& /‘ s A(4) %1009
7@ RDB [& \—» B(-)
CA3-ADPTRM-01 SDA = : SG
CA3-ADPCOM-01 SDB Vo
SG
FG
User-created cable
e 1:n Connection
Display side
Terminal Block . External Device side External Device side
Signal name ... Shield Terminal Block  Terminal Block
Displ 4 R . - Termination
Isplay TERMRX ; R Signal name | Signal name resistance
H 1 RDA |« :.' /A :: I“t A(+) A(+) %IOOQ
//:1 RDB |« S B(-) B(-)
CA3-ADPTRM-01 SDA : : SG SG
CA3-ADPCOM-01 SDB ',‘
SG
FG
User-created cable
NOTE I « Connect External Devices using side connectors.
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4B)
e 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Termination

Termination . . .
. Pin i .
resistance Signal name - Sh'eld . Signal name resistance

1000 % RDA . A e A+) %:LOOQ

SDA
SDB
SG
ERA
CSA
ERB

6 CSB
Shell FG

A

SG

O |0 |dh|lOIN]|WIN]|E

e 1:n Connection

External Device side External Device side

Display side
Terminal Block ~ Terminal Block

D-Sub 9pin (socket)
Termination Pin |Signal name Shield Signalname | Signal name Termination
resistance

resistance | 1" .. R
RDA f—A— A Al %ﬂm

1OOQ%
Display B(-) B(-)
SG SG

RDB
SDA
SDB
SG
ERA
CSA
ERB
6 CSB
Shell FG

A
f

O |0 |dP|lOIN|IWIN]|E

NOTE « Connect External Devices using side connectors.
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4C)
e 1:1 Connection

Display side

Terminal Block External Device side

Signal name Shield Terminal Block
Display TERMRX .." ---------- '.-"‘-_ Signal name Termination
' ros resistance
[ C RDA : /‘ :' —> A ;\3;1009
7& RDB |« \__‘_, B(-)
CA3-ADPTRM-01 SDA SG
CA4-ADPONL-01 SDB
SG - L
FG
) User-created cable g
« 1:n Connection
Display side
Terminal Block External Device side External Device side
Signal name Shield Terminal Block ~ Terminal Block
Display TERMRX —— 2| Signalname | Signalname |  Termination
[ =] | _Roa A A A(+) %rl%%gance
// LIl roB |« /\4_‘_, B(-) B(-)
CA3-ADPTRM-01 SDA SG SG
CA4-ADPONL-01 SDB :'-
SG '
FG

A 4

A

User-created cable

» Connect External Devices using side connectors.
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Display side

D-Sub 9pin (plug)
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External Device side

Pin | Signal name Shield Terminal Block
. R ’, . -
Display 1 |TERMRX . Y Signal name Ter_mmauon
! N ' resistance
2 RDA |« /‘ ——|  A(+) ?:;1009
7 | RDB |& \—‘—> B(-)
3 | SDA |— SG
CA4-ADPONL-01 ' H
8 SDB T '
5 SG . ;
Shell FG
User-created cable
« 1:n Connection
Display side
D-Sub 9pin (plug)
- . External Device side External Device side
‘ Pin | Signal name Shield Terminal Block ~ Terminal Block
Display 1 |TERMRX | Y Signalname | Signal name | ~ Termination
K ro resistance
2 RDA [« /A e A(+) A(+) %1009
7 | RDB |e \4—-—> B(-) B(-)
3 SDA L SG SG
CA4-ADPONL-01 [ o SDB
5 SG
Shell FG

A 4

A

User-created cable

¢ Connect External Devices using side connectors.

NOTE I
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4E)
e 1:1 Connection

Display side

Terminal Block External Device side

Terminal Block

Signal name

...............

TERMRX SN
RDA |« A— > A>)
RDB |« / \—» B(-)
SDA SG
SDB
SG
FG

Termination
resistance

%1009

Display Signal name

=
CA3-ADPTRM-01
CA3-ADPCOM-01

A
v

User-created cable

¢ 1:n Connection

Display side

Terminal Block External Device side External Device side

Signalname |~ Shield Terminal Block  Terminal Block
Display TERMRX [— 7% | Signalname | Signal name |  Termination
: L resistance
o s 1000
[ = RDA |+ AR A+) A+) %
//:1 RDB |« — B(-) B(-)
CA3-ADPTRM-01 SDA ' . SG SG
CA3-ADPCOM-01 SDB
SG
FG

A
v

User-created cable

¢ Connect External Devices using side connectors.

NOTE I
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4F)
e 1:1 Connection

Display side External Device side
D-Sub 9pin (socket) Terminal Block
Term_ination Pin |Signal name Shield Signal name Ter_mination
resistance p——————vF———— = remm-mmaaa--- resistance
1000 % 1 |DATA+ [e——HA AR %1009
Display 2 |DATA-Je——/ = B(-)
3 | Nneo| ; SG
7 | N |
5 |GND(SG) |—
4 | ERA
8 | csa ::I
o | ERB
6 CSB :
Shell FG
e 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (socket) Terminal Block  Terminal Block
emance | Pin Jsodrne] - shied [ sgranane [ Sgnairane ] - Temnaton
10002 1 |DATA+ |« :-' A——  A(+) A(+) %1009
Display % 2 [DATA-|e—— \— B(-) B(-)
3 NC ' SG SG
7 NC
5 |GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG

NOTE I

¢ Connect External Devices using side connectors.
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4G)
e 1:1 Connection
Display side External Device side
Terminal block Terminal Block
. . : Terminati
Termination | Signal name .Shield Signal name r:Srir;'t';‘ﬁC':”
resistance*1 RDA |e—< A UL A(+) 100Q
Display % RDB |e—: /\_.'_I'.I.> B(-) %
SDA |— i~ SG
SDB |— P
ss " i
CSA [+ N
CSB [« i
« 1:n Connection
Display side External Device side External Device side
Terminal block Terminal Block ~ Terminal Block
Termination | Signal name Shield Signal name | Signalname | ~ Termination
resistance*1 e - resistance
% RDA |e— A—p  A(+) A(+) %1009
Display RDB { S\ S B(-)
SDA SG SG
SDB
SG
ERA
CSA
ERB
CSB

NOTE « Connect External Devices using side connectors.

*1  The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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Display side External Device side
D-Sub 9pin (plug) Terminal Block
Termination Pin | Signal name __ Shield Signal name Ter-nlinf;ig”
reS|st1a0nOc§ 3 LINE() [« AL %OOQ
Display % 8 LINE(-) 4——/ — B(-)
1 NC —1__SG
e | w |1
5 GND(SG) [ P
4 RS(RTS) | !
6 5V
7 NC I
9 NC H L
Shell FG . S i
e 1:n Connection
Display side External Device side External Device side
D-Sub 9pin (plug) Terminal Block  Terminal Block
Tormneee [pn [sowne]  Sted [ Sgaane | Sipaine | Teminaion
‘ 100(2% 3 LINE(+) [« '," A :' ". > A(+) A(+) %1000
Display s | UNeQ 4——/ —>  B() B(-)
] NG : P SG SG
2 NC P
5 GND(SG)
4 RS(RTS) :
6 5V Lo
7 NC :
9 NC | \
shell | Fa  —3 T B

IMPORTANT S The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE « Connect External Devices using side connectors.

* |n COM on the GP-4107, the SG and FG terminals are isolated.
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41)

1:1 Connection

Display side

Terminal Block

External Device side

Signal name Sh'e'd ______ Terminal Block
Display TERMRX —- Signal name Termination
H A K H resistance
7@ RDB [« ——  B(-)
PFXZCBADTM1 SDA = ' SG
SDB
SG
FG
User-created cable
« 1:n Connection
Display side
Terminal Block ) External Device side External Device side
Signal name Sh'eld Terminal Block ~ Terminal Block
. . SN - - Termination
Display TERMRX ; P Signal name | Signal name resistance
P A Ly 100Q
// 1 RDB [« ] : B(-) B(-)
PFXZCBADTM1 SDA I SG SG
SDB \
SG
FG

A\ 4

A

User-created cable
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4])
e 1:1 Connection

External Device side
Terminal Block

Displa D1 Signal name ::srigiar\]r?(t:ign
= A(+) %1009
DO B()
(1) GND G

e 1:n Connection

External Device side External Device side

Termination
resistance Terminal Block  Terminal Block
2200(1/4W) Signal name | Signalname |  Termination
Display D1 resistance
g A(+) A(+) %220()(1/4W)
Do B(-) B(-)
(1) GhD SG SG
Number Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRJR81

¢ Connect External Devices using side connectors.

NOTE I
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6 Supported Devices

The following table shows the range of supported device addresses. Please note that the actually supported range
of the devices varies depending on the External Device to be used. Please check the actual range in the manual of
your External Device.

Input address of external device in the dialog below.

I\ peicsric [pcr 5] 3
o [=[[ooo1
Back Cir
ale|c 7|a]a
p|E|F 4[5]s

2 1]2]3

\Referenoe | 0 Ent

1. Device Set Device.

2. Reference The list of available identifiers is displayed.
Click the identifier to use and press "Select," and the address is entered.

3. Address Set Address.
The combination of identifier and address differs depending on the external device.

W The following description explains the memory maps for each parameter.

<When using Bit Data>
Bit Data (Read Only) : Function [02H]

Relative . 1 Memory

Address Coil No. Type TS Read-out Data
0000H 10001 Bit Alarm1 ON/OFF | 0: Alarm1 OFF, 1: Alarml1 ON
0001H 10002 (Reserved)
0002H 10003 (Reserved)
0003H 10004 (Reserved)
0004H 10005 Bit Alarm2 ON/OFF | 0: Alarm2 OFF, 1: Alarm2 ON
0005H 10006 (Reserved)

*1  Coil No. is the address that is assigned by the Display.
Example: For the parameter "Alarm1 ON/OFF" of Coil No. 10001, the Display’s designated address is as follows.
Use the first digit of the Coil No. (00001 -, 10001 -) to designate the device.
10001

Address (The last four digits of the Coil No.)
Device (The first digit of the Coil No.)

GP-Pro EX Device/PLC Connection Manual 67



Temperature Controller MODBUS SIO Driver

Example: For the parameter “front surface control SV data" of Register No. 41003, the Display’s designated address
is as follows. Use the first two digits of the Register No.s (30001 -, 40001 -, 31001 - and 41001 -) to
designate the device.

41 003

Address (The last three digits of the Coil No.)
Device (The first two digits of the Coil No.)

« The External Device’s parameter data, when data transfer is performed, will have no
decimal places. Thus, in the Display, processing must be performed to correct the data.
For example, if a numeric display is used that includes decimal places, the "No. of
Decimals" of the "Display" settings must be used. Also, when writing data to a External
Device, it is necessary to write decimal values as integers.

Example: Register No. 41025’s "Output 1 Lower Limit"
External Device Display/Setting Value : 3.00%
Display value/setting : 3000

Please refer to your External Device manual for details (with/without a decimal point)
about data item setting value ranges.

6.1 PXH series
(=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30257 - 31407 HiL L& 3112
Word Data 40001.00 - 45035.31 40001 - 45035 ‘ e e 9l 2%

*1  Write disabled.
*2  This device is 32 bits in length. Only odd addresses can be assigned.

*3  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

*4 43153 is an address to order writing in the nonvolatile memory (FIX processing).
Writing in the nonvolatile memory is performed by entering 1 (one) to the writing value.

NOTE « You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.
Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.2 PXG series
[E=—= This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Bit Data 10001 - 10013 - 1
Read Only Word Data (Internal) - 30001 - 30062 9™
Read Only Word Data ) i HiL *]
(Engineering Unit) 31001 - 31062 l;l m

Word Data (Internal) 40002.00 - 40628.15 40002 - 40628 9]
Word Data (Engineering Unit) | 41002.00 - 41628.15 41002 - 41628 9] ™

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE « You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.3 PXR (AutoFIX) / PXR (NoAutoFIX) series

[E=—= This address can be specified as system data area.

Device

Bit Address

Word Address

32bits

Notes

Bit Data

00001

Read Only Bit Data

10001 - 10016

10001

*1

m *1*3
m *1*3

*1 00001, 40001, and 41001 are addresses to order writing in the nonvolatile memory (FIX processing).
Writing in the nonvolatile memory is performed by entering 1 (one) to the writing value.

*2  Write disabled.

*3  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

Read Only Word Data (Internal) - 30001 - 30037

HIL

Read Only Word Data

(Engineering Unit) ) 31001 - 31037

Word Data (Internal) 40001.00 - 40120.15 40001 - 40120

Word Data (Engineering Unit) 41001.00 - 41120.15 41001 - 41120

* You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
6.4 PUM series (PUMA / B)
[E=—= This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes

Read Only Word Data - 30001 - 34061

‘HIL|

Word Data 40001.00 - 45032.15 40001 - 45032

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

* You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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6.5 PUM series (PUME)
[E=—= This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30064 - 31003 HIL o)™
Word Data 40021.00 - 41016.15 40021 - 41016 ‘ B i t'I 5| "2

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE « You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
6.6 PUM series (PUMV /N /T)
=== This address can be specified as system data area.
Device Bit Address Word Address 32bits Notes
Read Only Word Data - 30001 - 34061 HiL 9™
Word Data 40017.00 - 45032.15 40017 - 45032 ‘ B i t'I 5| 2

*1  Write disabled.

*2  When you write to the bit address, the Display reads the entire word, sets the defined bit, then returns the new
word value to the External Device. If the ladder program writes data to this word address during the bit write
process, the resulting data may be incorrect.

NOTE « You can only set the Read Area Size for the system area available to use in the External
Device. Please refer to the GP Pro-EX Reference Manual for Read Area Size.

Cf. GP Pro-EX Reference Manual "LS Area (Direct Access Method Area)"
« Refer to the precautions on manual notation for icons in the table.

&~ "Manual Symbols and Terminology"
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7 Device Code and Address Code

Use device codes and address codes when you set "Device Type & Address" for the address type of the data

display or other devices.

7.1 PXH series
Device Code
Device Device Name Vi Address Code
(HEX)
Read Only Word Data 3 0001 Value of (word address -1) divided by 2
Word Data 4 0000 Value of (word address -1) divided by 2
7.2 PXG series
Device Code
Device Device Name Address Code
(HEX)
Read Only Word Data (Internal) 30 0001 Value of (word address - 1)
Reaq Only Word_ Data 31 0003 Value of (word address - 1)
(Engineering Unit)
Word Data (Internal) 40 0000 Value of (word address - 1)
Word Data (Engineering Unit) 41 0002 Value of (word address - 1)
7.3 PXR (AutoFIX) / PXR (NoAutoFIX) series
Device Code
Device Device Name Address Code
(HEX)
Read Only Word Data (Internal) 30 0001 Value of (word address - 1)
Reaq Only Word_ Data 31 0003 Value of (word address - 1)
(Engineering Unit)
Word Data (Internal) 40 0000 Value of (word address - 1)
Word Data (Engineering Unit) 41 0002 Value of (word address - 1)
7.4 PUM series
Device Code
Device Device Name Address Code
(HEX)
Read Only Word Data 3 0001 Value of (word address - 1)
Word Data 4 0000 Value of (word address - 1)
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8 Error Messages

Error messages are displayed on the Display screen as follows: "No. : Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

Item Description
No. Error number
Device Name Name of the Exte_rnal De\{ice where an error _h:as occurred. Device/PLC name is the title of
the External Device set with GP Pro-EX. (Initial value [PLC1])
Error Message Displays messages related to an error that has occurred.

Displays the IP address or device address of the External Device where an error has
occurred, or error codes received from the External Device.

Error Occurrence Area NOTE

 |P address is displayed as "IP address (Decimal): MAC address (Hex)".
 Device address is displayed as "Address: Device address".
» Received error codes are displayed as "Decimal [Hex]".

Examples of Error Messages
"RHAAOQ035:PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE « Refer to your External Device manual for details on received error codes.
« Refer to "Display-related errors” in *Maintenance/Troubleshooting Manual” for details on the

error messages common to the driver.

B Error Codes Unique to External Device

Error Code Description
0x02 Faulty address for coil or resistor
0x06 Busy condition
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